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Résume 

Une chaîne d’acquisition permet d’extraire les infirmations qui  caractérisent le milieu 

extérieur, dans notre cas la grandeur à extraire comme information est l’image pour nous 

renseigner sur l’extérieur ensuite faire le traitement nécessaire et agir selon la situation par un 

actionneur. Dans notre cas c’est un moteur pas à pas qui permet le suivi d’un objet selon son 

mouvement linéaire (un seul degré de liberté). 

 Cependant, le circuit numérique adéquat nécessite une architecture plus lourde et le 

traitement des informations doit se faire en parallèle (acquisition et actionnement) pour se 

rapprocher plus de la notion temps réel. 

 Pour cela notre choix s’est posé sur un circuit FPGA qui repend à nos exigences, qui 

permet une exécution parallèle des informations à une vitesse considérable. 

 Notre travail consiste a implémenter une application sur FPGA qui permet le 

traitement des données (images) reçue du capteur (CCD) pour détecter la position d’un objet 

dans l’image par rapport a une image référence (l’objet se situe au centre) et veiller à ce que 

cet’objet soit conduit et ramené au centre, en tournant le capteur fixé sur le moteur dans le 

sens et la position correspondant.  

 Cette tache a été réalisée en utilisant une carte DE2 d’Altéra, dans l’environnement de 

programmation  Quartus et pour cela nous avons opté au plan suivant : 

Les circuits programmables sont présentés au chapitre I, la carte de développement DE2 

d’Altéra, et le support d’utilisation est présenté en chapitre II, l’application et les résultats sont 

présentés en chapitre III. Enfin nous terminons par une conclusion.     

Ce travail noua a permet de découvrir le monde de la programmation des systèmes 

embarqués et le domaine du temps réel, j ai eu l’occasion de programmer expérimentalement 

un circuit logique programmable de type FPGA, sous l’environnement de développement 

QUARTUS d’ALTERA sous différents modes de programmation. 

 

Mots clés : 

FPGA, VHDL, Quartus, Implimentation, Tracking.  



Sommaire 

Introduction Générale  

 

Chapitre I : Les circuits logiques programmables 

I.1 Introduction ………..……………………………………………………………………1 

I.2 Structure de base d’PLD ........................................................................... 1 

I.3 Les différentes familles de PLD .................................................................. 2 

I.3.1 Les  PALs (Programmable Array logique ou réseau logique programmable) ........... 2 

I.3.2 Les GAL (GENERIC ARRAY LOGIC) ...................................................... 4 

I.3.3 Les EPLD (Erasable Programmable Logic Device) ......................................... 4 

I.3.4 Les CPLD (Complex Programmable Logic Device) ........................................ 4 

I.3.5 Les FPGA (Field Programmable Gate Array) ................................................ 5 

I.3.5.1 Généralité ........................................................................................ 5 

I.3.5.2 Les différents types de FPGA ................................................................ 7 

I.3.5.2.1 Les FPGA du type anti fusible ............................................................. 7 

I.3.5.2.2 Les FPGA du type SRAM .................................................................. 8 

I.4 Etude de la structure générale d’un circuit  FPGA ............................................. 9 

I.4.1 Les cellules logiques de base ................................................................... 9 

I.4.2 Réseau d’interconnexion ...................................................................... 11 

I.4.3 Les éléments de mémorisation ................................................................ 13 

I.4.4 Les éléments de contrôle et d’achèvement des horloges .................................. 13 

I.4.5 Les éléments de routage ....................................................................... 14 

I.5 Illustration avec la famille Cyclone II Altera ................................................. 14 

I.5.1 Caractéristiques principales de la famille Cyclone II ..................................... 14 

I.5.2 Architecture interne globale................................................................... 15 

I.6 Conclusion ......................................................................................... 19 

 

 



Chapitre II : Présentation de la carte DE2 

II.1 Introduction ....................................................................................... 20 

II.2 Vue générale sur la carte DE2 ................................................................. 20 

II.3 Schema bloc de la carte DE2 ................................................................... 21 

II.3.1 Les constituants de la carte DE2 ............................................................ 22 

II.4 La tension d’alimentation ....................................................................... 25 

II.5 Utilisation de la carte DE2 ..................................................................... 25 

II.5.1 Configuration du FPGA Cyclone II ......................................................... 25 

II.5.1.1 programmation du FPGA en mode JTAG ............................................... 26 

II.5.1.2 Programmation de l EEPROM EPCS16 en mode AS ................................. 27 

II.5.2  Utilisation des boutons-poussoirs et des Switchs ........................................ 27 

II.5.3 Utilisation des LEDs .......................................................................... 29 

II.5.4 Utilisation des afficheurs 7 segments ....................................................... 30 

II.5.5 Les horloges d’entrées ........................................................................ 31 

II.5.6 Utilisation de l’afficheur LCD ............................................................... 32 

II.5.7 Utilisation des ports d'extension ............................................................. 33 

II.5.8 Utilisation du port VGA ...................................................................... 34 

II.5.9 Utilisation du codec audio 24-bit ............................................................ 35 

II.5.10 Le port série  RS-232 ........................................................................ 36 

II.5.11 Le port série PS / 2 ........................................................................... 37 

II.5.12 Contrôleur Fast Ethernet  ................................................................... 37 

II.5.13 Le décodeur TV .............................................................................. 38 

II.5.14 La mise en œuvre d'un encodeur TV ...................................................... 38 

II.5.15 Utilisation de l’USB Host (pilote) et Périphérique ...................................... 39 

II.5.16 L'utilisation du IrDA ......................................................................... 40 

II.5.17 Utilisation des RAM flash SDRAM / SRAM ............................................ 41 

II.6 Conclusion ........................................................................................ 42 

 



Chapitre III : Application 

III.1 Introduction ...................................................................................... 43 

III.2 Capteur CCD ou CMOS ....................................................................... 43 

III.3 Généralités sur l’image ........................................................................ 43 

III.3.1 Le Pixel ........................................................................................ 43 

III.3.2 L’image ........................................................................................ 43 

III.3.2.1 Définition .................................................................................... 43 

III.3.2.2 Types d'images ............................................................................. 44 

III.3.2.3 Représentation des images ................................................................ 44 

III.3.2.4 L’image RGB (RVB) ...................................................................... 44 

III.4 La plateforme de développement Quartus .................................................. 45 

III.4.1 Présentation.................................................................................... 45 

III.4.1.2 L’environnement de Quartus II .......................................................... 46 

III.4.1.3 Devloppement sous Quartus II ........................................................... 47 

III.5 Description du moteur pas a pas .............................................................. 49 

III.5.1 Généralités : ................................................................................... 49 

III.5.2 Commande d’un moteur pas à pas ......................................................... 50 

III.5.1.1 Les différents modes de commande des moteurs pas à pas .......................... 51 

III.6 La partie programmation ...................................................................... 53 

III.6.1 Principe et raisonnement .................................................................... 53 

III.6.2 Mise en application ........................................................................... 56 

III.6.3 Résultats de simulation ...................................................................... 58 

III.7 Conclusion ....................................................................................... 59 

Conclusion 

Bibliographie   

Annexe   



 

 

 

 

 

 

 

 

 

 

 

 

 

 

 



Introduction 

 

 Une chaîne d’acquisition permet d’extraire les infirmations qui  caractérisent le milieu 

extérieur, dans notre cas la grandeur à extraire comme information est l’image pour nous renseigner 

sur l’extérieur ensuite faire le traitement nécessaire et agir selon la situation par un actionneur. Dans 

notre cas c’est un moteur pas à pas qui permet le suivi d’un objet selon son mouvement linéaire (un 

seul degré de liberté). 

 Cependant, le circuit numérique adéquat nécessite une architecture plus lourde et le 

traitement des informations doit se faire en parallèle (acquisition et actionnement) pour se 

rapprocher plus de la notion temps réel. 

 Pour cela notre choix s’est posé sur un circuit FPGA qui repend à nos exigences, qui permet 

une exécution parallèle des informations à une vitesse considérable. 

 Notre travail consiste a implémenter une application sur FPGA qui permet le traitement des 

données (images) reçue du capteur (CCD) pour détecter la position d’un objet dans l’image par 

rapport a une image référence (l’objet se situe au centre) et veiller à ce que cet’objet soit conduit et 

ramené au centre, en tournant le capteur fixé sur le moteur dans le sens et la position correspondant.  

 Cette tache a été réalisée en utilisant une carte DE2 d’Altéra, dans l’environnement de 

programmation  Quartus et pour cela nous avons opté au plan suivant : 

Les circuits programmables sont présentés au chapitre I, la carte de développement DE2 d’Altéra, et 

le support d’utilisation est présenté en chapitre II, l’application et les résultats sont présentés en 

chapitre III. Enfin nous terminons par une conclusion.     
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I.1 Introduction 

               Il y a quelques années la réalisation d’un montage en électronique numérique 

impliquait l’utilisation d’un nombre important de circuits intégrés logiques. Ceci avait pour 

conséquences un prix de revient élevé, une mise en œuvre complexe et un circuit imprimé de 

taille importante.  

               Le développement des mémoires utilisées en informatique fut à l’origine des 

premiers circuits logiques programmables (PLD : programmable logic device). Ce type de 

produit peut intégrer dans un seul circuit plusieurs fonctions logiques programmables par 

l’utilisateur. Sa mise en œuvre se fait très facilement à l’aide d’un programmateur, d’un 

micro-ordinateur et d’un logiciel adapté. 

I.2 Structure de base d’PLD 

             La plupart des PLDs suivent la structure suivante :  

� Un bloc d’entrée qui permet de fournir au bloc combinatoire l etat de chaque entrée et 

de son complément. 

� Un bloc combinatoire et logique qui comporte 

• Un ensemble d’opérateurs « ET » sur lesquels viennent se connecter les variables 

d’entrée et leurs compléments.  

• Un ensemble d’opérateurs « OU » sur lesquels les sorties des opérateurs « ET » 

sont connectées.  

� Un bloc de sortie. 

� Un bloc d’entrée-sortie.  

Une éventuelle structure de sortie (Portes inverseuses, logique 3 états, registres...).  

             Les deux ensembles logiques forment chacun ce qu’on appelle une matrice. Les 

interconnexions de ces matrices doivent être programmables. C’est la raison pour laquelle 

elles sont assurées par des fusibles qui sont grillés lors de la programmation. Lorsqu’un PLD 

est vierge toutes les connexions sont assurées.  
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Un exemple de ce type de structure est présenté par la figure suivante. 

 

Figure I.1 Structure de base d’un PLD 

 

I.3 Les différentes familles de PLD 

               Il existe plusieurs familles de PLD qui sont différenciées  par leur structure interne. 

Le tableau suivant présente certaines de ces familles. 

   TYPE Nombre de portes intégrées Matrice ET Matrice OU Effaçable 

  PAL  10 à 100 Programmable Fixe Non 

  GAL  10 à 100 Programmable Fixe Electriquement 

  EPLD  100 à 3000 Programmable Fixe Par U-V 

  FPLA  2000 à 3000 Programmable Programmable Electriquement 

  FPGA  Plus de 50 000 Programmable Programmable Electriquement 

 

Tableau 1 récapitulatif des différentes familles des PLDs 

I.3.1 Les  PALs (Programmable Array logique ou réseau logique 

programmable) 

   Les PALs, ce sont les premiers circuits intégrés programmables pour réaliser des 

fonctions logiques. Ce type de circuit a été développé par le constructeur AMD. Ils sont 

constitués de matrices ‹‹ET›› programmables et de matrices ‹‹OU›› fixes.  
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La programmation de ces PAL s’effectue par la destruction des fusibles, et une fois 

programmés on ne peut plus les effacer.  

   On distingue deux sous familles : 

� Les PAL combinatoires (simple) 

Ce  type de PAL possède une architecture interne la plus simple car il possède uniquement  

des portes logiques, ils sont conçus pour la représentation des fonctions de logiques 

combinatoires. 

� Les PAL séquentielles  

   Parmi les types de PAL séquentielle on distingue trois types qui sont : 

 

• Les PAL à registre (FPLS) 

Les PALs à registres ou FPLS (Field Programmable Logic Séquencer), c’est 

séquenceur sont constitués de portes logiques, de bascules et de registres. 

• Les PAL asynchrone à registre 

Ce type de PAL diffère du précédent de la manière de répartition et distribution du 

signal d’horloge  vis-à-vis des bascules internes, en effet, dans ce type chaque bascule dispose 

de son propre signal d’horloge (combinaison de signaux avec des multiplicateurs), aussi il 

possède un multiplexeur qui permet la sélection du registre avec les entrées de sélection AP et 

AR qui sont aussi des reset asynchrones.  

• Les PAL versatiles (VPAL) 

   Ces VPAL présentent une évolution des PAL vers les circuits logique programmable 

de haut niveau, en effet ils continuent à respecter les principes généraux des PALs mais 

utilisent une structure de cellule de sortie très proche des macro-cellules ou OLMC des GALs 

que nous verrons par la suite, la structure de ça sortie est dite versatile et configurable, le 

mode de fonctionnement est obtenu en utilisant deux multiplexeurs qui  utilisent  comme  

signal  de  sélection  les points  de  programmation  S0  et  S1, la combinaison de S0 et S1 

donne les différentes configurations de la sortie. 
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I.3.2 Les GAL (GENERIC ARRAY LOGIC)  
             Les PALs possèdent un inconvénient majeur qui réside dans l’impossibilité de la 

reprogrammation une deuxième fois, dans le but de remédier a ce problème on a penser à 

remplacer les  fusibles irréversibles des PALs par des transistors MOS FET pouvant être 

regénérés, ces circuits peuvent donc être reprogrammés à volonté sans pour autant avoir une 

durée de vie restreinte et cela a donné naissance a ce qu’on appelle GAL, on a aussi  remplacé  

la technologie bipolaire des PALs par la CMOS dans les GALs ce qui a réduit la 

consommation de l’énergie. 

I.3.3 Les EPLDs (Erasable Programmable Logic Device)  

               Les  EPLDs sont des circuits  logiques  programmables électriquement et effaçable, 

soit par ultraviolets ou électriquement, Ces circuits, comme les PAL et les GAL, font  appel à 

la notion  de  macro-cellule  qui  permet, par  programmation, de réaliser  de  nombreuses  

fonctions  logiques  de  base. Ils  sont  caractérisés  par  leur  densité d’intégration  qui  est  

nettement  supérieure  à  celle offerte  par  les  PAL  et  une  vitesse  de fonctionnement 

comparable à celle des PALs bipolaires. En plus de  ces deux caractéristiques,  les  EPLD  

possèdent  un  atout  majeur  qui  réside  dans  la  possibilité d’effacement, ils ont  été  mis en 

œuvre par  la  firme ALTERA qui les a commercialisé pour la première fois en 1984.   

I.3.4 Les CPLD (Complex Programmable Logic Device)  

               Les PAL, GAL, CPLD et EPLD, sont de conception plus ancienne, utilisent des 

« macro-cellules » logiques, composées d'un réseau combinatoire de portes ET et OU afin 

d'implémenter des équations logiques. Des bascules sont disponibles seulement dans les blocs 

d'entrée-sortie. Un composant contient de quelques dizaines à quelques centaines de macro-

cellules. 

Comme le routage est fixe, les temps de propagations sont bornés et permettent une fréquence 

de fonctionnement élevée et indépendante du design. Par contre, l'utilisation des ressources 

n'est pas optimale (tout terme non utilisé dans une équation logique équivaut à des portes 

perdues), avec des taux d'utilisation d'environ 25 %. 

On distingue les CPLD des autres PLD car ils contiennent l'équivalent de plusieurs 

composants PLDs, reliés par une matrice d'interconnexion. Un certain nombre de macro- 

cellules de base sont regroupées pour former des blocs logiques. Grâce à leurs structures, ils 

peuvent atteindre des vitesses de fonctionnement élevées  (plusieurs  centaines  de  MHz).  
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Ces  circuits  ont  une  capacité  en  nombre  de portes et en possibilités de configuration très 

supérieure à celle des précédents. 

Figure I.2 Physionomie d’un CPLD 

I.3.5 Les FPGA (Field Programmable Gate Array) 

             Un FPGA (réseau de cellules logiques programmables) est un circuit logique 

reprogrammable. Les FPGAs sont des circuits intégrés qui contiennent des blocs logiques 

configurables (programmables), ainsi que des interconnexions entre ces blocs configurables.  

Les premiers circuits intégrés reconfigurables de type FPGA ont été commercialisés par la 

société XILINX en 1984 et commercialisé en 1985. Depuis d’autres fabriquants  sont apparus 

sur ce marché comme ALTERA, ACTEL, Texas Instrument….  Au fur et à mesure que la 

complexité des FPGA s’est développée, jusqu'à concurrencer sérieusement les circuits 

spécifiques (les ASICs) pour de petits volumes d’integration. C’est pourquoi on envisage de 

plus en plus de développer l’utilisation des FPGA dans les diverses applications. 

I.3.5.1 Généralité  

       Les FPGAs sont utilisés dans diverses applications de l'électronique numérique 

(télécommunications, aéronautique, …), ils sont également utilisés pour le prototypage des 

ASICs. Ils ont plusieurs avantages : 

• Délai de mise sur le marché plus court, car ce sont des composants standards, 

• Temps de développement plus court, car on réutilise des fonctions de base et la 

reconfigurabilité autorise une validation préalable moins stricte, 
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• Coût inférieur pour de petites séries (moins de 10 000 unités). Avec l'évolution         

technologique, cette quantité tend à augmenter, en effet, le prix d'une puce est 

proportionnel à sa surface, qui diminue avec la finesse de gravure. 

• Il est parfois possible de transformer directement un FPGA en une version ASIC plus 

rapide, moins chère et consommant moins (car les matrices de routage sont remplacées 

par une couche de métallisation fixe). 

• Plusieurs FPGA modernes possèdent la possibilité d'être reconfigurés. 

 

Figure I.3 Physionomie d’un FPGA 
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Figure I.4 Structure générale d’un FPGA 

I.3.5.2 Les différents types d’FPGAs  

   Les FPGAs ont différentes  architectures   et on distingue deux types principaux de 

FPGA qui sont : 

� Les FPGAs à anti fusibles proposé entre autre, par Texas Instrument et ACTEL.  

� Les FPGAs de type SRAM, appelé LCA chez XILINX et FLEX chez ALTERA.   

Ces deux technologies différent essentiellement dans la façon dont leurs 

interconnections sont réalisées 

I.3.5.2.1 Les FPGAs de type anti fusible  

               Les réseaux programmables à anti-fusibles sont des composants configurables une 

seule fois. 

Les anti-fusibles sont des composants généralement constitués de deux couches conductrices 

entourant un diélectrique. L’application d’une tension élevée fait claquer le diélectrique créant 

une liaison entre les  deux  couches  conductrices  du  composant.  Les  anti-fusibles  peuvent  

donc  être  considérés  comme des  circuits  ouverts  dans  leur  état  initial,  et  des  circuits  
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fermés  une  fois  programmés.  La  Figure ci-dessous montre  un  anti-fusible  utilisé  pour  

configurer  une  connexion  entre  deux  fils.  L’avantage  de  cette technologie est sa faible 

taille, même si les transistors utilisés pour la configuration sont dimensionnés de manière à 

laisser passer de forts courants lors de la programmation et réaliser une bonne isolation entre 

les tensions élevées de configuration et les faibles tensions de fonctionnement, et sont de fait 

de taille imposante. Les autres points forts de ces composants sont leur haut niveau de 

confidentialité, due aux  difficultés  de  relecture  de  l’état  du  fusible,  et  leur  faible  

sensibilité  aux  radiations  et  autres perturbations  environnementales,  induisant  une  bonne  

fiabilité.  Ces  caractéristiques  impliquent cependant un manque de flexibilité, ainsi que des 

fortes tensions de programmation. 

Figure I.5 Programmation par anti-fusible 

I.3.5.2.2 Les FPGAs de type SRAM  

              La  structure  de  base  d’un  FPGA  de  type  SRAM  est  complexe, le point  de 

connexion entre les différentes cellules est un ensemble de transistors MOS de commutation 

commandés par des cellules de mémoire vive (RAM). 

Les mémoires SRAM sont également utilisées pour la conception de réseaux programmables 

du fait de leurs performances (leur rapidité d’accès notamment) et de leur faible coût. On 

trouve deux grandes architectures pour ces points mémoires, les 6T-SRAM et 5T-SRAM, 

respectivement  à  six  et  cinq  transistors.  La  cellule  à  six  transistors  est  constituée  de  

deux  inverseurs montés tête-bêche et deux transistors d’accès (Figure II.6). Elle est 

commandée par le bit « Word Line »  (WL,  Figure II.6.a)  pour  l’écriture  et  la  lecture.  On  

positionne  des  valeurs complémentaires  sur  BL et BL| tout en ayant WL à « 1 » pour écrire 
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une donnée BL. On laisse les lignes BL et BL| flottantes et on positionne WL à « 1 » pour lire 

la donnée contenue par le point mémoire. 

 

Figure I.6 Cellule SRAM à six transistors            Figure I.7 Cellule SRAM à cinq transistors 

 

La configuration  est  stockée  dans  une  mémoire  SRAM  qui  présente  l’avantage  d’être  

relativement compacte et rapide, bien qu’elle est aussi volatile et sensible aux radiations 

naturelles. 

I.4 Etude de la structure générale d’un circuit  FPGA    

I.4.1 Les cellules logiques de base 

On distingue deux principaux types de cellules de base qui sont : 

� Les cellules d’entrées-sorties  

Ils  constituent  l’interface  entre  les  branches de sortie  du  circuit  et  les  CLB.  Ils  

sont  présents  sur toute la périphérie du circuit FPGA car ces cellules sont des intermédiaires 

par lesquelles les données transitent depuis les blocs logiques internes jusqu’aux ressources 

externes et vice versa. Chaque bloc  IOB contrôle une broche du  composant et peut être 

défini en entrée, en sortie, en entrée/sortie. 
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Le rôle principal des interfaces d’entrés/sorties est de transmettre et de recevoir des 

données du milieu extérieur, néanmoins l’interface d’entré/sorties peut être dotée d’options 

tels que des registres, impédances et buffers. 

             Chaque fabricant a sa propre appellation pour désigner l’interface d’entrés/sorties 

mais la fonction reste toujours la même.   

- Chez XILINX, les interfaces d’entrés/sorties sont nommées IOB pour Input Output 

Blocks. L’IOB est constitué de registres, de diviseurs de tensions, des résistances de rappel 

pull up et autres ressources spécifiques.  

- Altera, les nomme IOE Input Output Element. L’IOE remplie toujours son rôle 

d’interface d’entrés/sorties, elle dispose d’une résistance de rappel pull-up et un temporisateur 

du signal.  

� Les macro-cellules  

Ces cellules logique sont appelé aussi par :  

-Soit CLB (configurable logique bloc), dénomination adoptée par XILINX. 

-Soit LC (cellule logique), le nom choisi par  CYPRESS. 

-Soit LE (élément logique), l’appellation d’ALTERA. 

 

Ces macro-cellules sont plus nombreuses. La macro-cellule est constituée d’une partie 

combinatoire et une partie séquentielle. 

• La partie combinatoire sur la quelle sont réalisées les fonctions de complexité 

moyenne car les constructeurs ont proposé pour chacun une ou plusieurs solutions de 

synthèse dont les principaux sont : 

� La synthèse de fonctions à 4 ou 5 variables avec des portes classiques ET, OU et NON 

(not). 

� La synthèse de fonction utilisant un multiplieur. 

� La synthèse de fonction combinatoire à l’aide de mémoire vive RAM.  

Dans ce dernier cas, on dit aussi réalisation de fonction logique par LUT (look-up ou table 

d’observation). 
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• La partie séquentielle est dans le FPGA est représentée par des  bascules, 

généralement de type D. il est rare de trouver des macro-cellules unique pourvues de 

la partie combinatoire. 

I.4.2 Réseau d’interconnexion  

             Dans les FPGA à architecture symétrique on peut distinguer une composante 

d’interconnexion locale et une composante d’interconnexion globale. La composante locale a 

pour rôle d’interconnecter les éléments des blocs logiques en fonction de la configuration. La 

deuxième  assure la circulation des données à l’échelle du FPGA entre les blocs logiques 

éloignés.  

� Au niveau local, on trouve donc des interconnexions configurables au sein des blocs 

logiques dans et entre les cellules logiques élémentaires. Elles  sont réalisées au 

moyen de multiplexeurs, de buffers trois états et de  portes passantes (un simple 

NMOS ou bien une porte de transmission associant un NMOS et un PMOS en 

parallèle). On trouve également un groupe d’interconnexions vers les blocs logiques 

directement adjacents selon le même principe. Il s’agit d’interconnexions courtes 

présentant de faibles retards si  on les compare aux interconnexions à longue distance.  

� Au niveau global, on trouve  un réseau d’interconnexions horizontales et verticales à 

l’échelle du circuit situé entre les blocs logiques montrés à la figure ci-dessous. 

Figure I.8 Concept architectural de base des FPGA 
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� On distingue trois types d’interconnexions : 

� Les interconnexions à usage général  

Ce Sont des lignes verticales et horizontales qui encadrent chaque CLB, auxquelles 

peut être reliée par une matrice de commutation montées à la figure II.8, le rôle de cette 

dernière est de raccorder les segments de communication entre eux selon diverses 

configurations, assure aussi la commutation des signaux d’une voie à autre.   

� Les interconnexions directes  

Ces interconnexions permettent d’établir des chemins entre les CLB adjacents et les 

cellules entrées/sorties avec un maximum d’efficacité en terme de vitesse et d’occupation de 

circuit.    

� Les longues lignes  

Sont des longues lignes verticales et horizontales qui n’utilisent pas de matrice de 

commutation. Elles parcourent toutes la longueur et la largeur du circuit. Elles permettent 

aussi de transporté les signaux qui parcourt un long trajet. Elles égalisent les délais entre les 

signaux de façon à permettre un décalage minimum entre deux points distants de la ligne. Ces 

lignes conviennent pour transporter les signaux d’horloge.           

� L’échange des données entre les  blocs logiques et ces interconnexions globales se fait 

par l’intermédiaire de Cellules d’Interconnexions Locales (CIL). L’aiguillage des 

données au sein du quadrillage d’interconnexions globales est assuré par des Cellules 

d’Interconnexions Globales (CIG) placées à chacune de ces intersections selon le 

schéma synoptique de la figure suivante. 
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Figure I.9 Réseau d’interconnexions dans l’FPGA 

I.4.3 Les éléments de mémorisation  

Actuellement,  Les  FPGAs  sont  utilisés  pour des applications plus complexes et  

plus importantes qui demandent un espace de stockage plus important à une vitesse élevée,  

d’où la nécessité d’intégrer  des blocs de mémoire directement dans l’architecture des FPGAs 

est vite devenue capitale. De cette  façon, les temps d’accès à la mémoire sont diminués 

puisqu’il n’est plus nécessaire de communiquer avec des éléments extérieurs au circuit. 

I.4.4 Les éléments de contrôle des horloges  

   L’horloge est un élément essentiel pour le bon fonctionnement d’un  système 

électronique.  

   Les circuits FPGA sont prévus pour recevoir une ou plusieurs horloges. Des entrées 

peuvent être spécialement réservées à ce type de signaux, ainsi que des ressources de routage 

spécialement adaptées au transport d’horloges sur de longues distances. Les circuits FPGA 

disposent des éléments d’asservissement des horloges (des PLL ou des  DLL) afin d’avoir la 

même horloge dans tout le circuit (synchronisation des signaux). Ces éléments permettent de 

créer à partir d’une horloge d’autres horloges  à des fréquences multiples de la fréquence de 

l’horloge incidente. 
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I.4.5 Les éléments de routage  

   Les éléments de routages sont les composants les plus importants dans les FPGA. En 

fait, ces éléments représentent la plus grosse partie du silicium consommée sur la puce du 

circuit. Ces ressources sont composées de segments  (de longueurs différentes) qui permettent 

de relier entre eux les autres éléments via de s matrices de connexions. Le routage de ces 

ressources est un point critique du développement d’une application sur un FPGA. Ces 

éléments sont très importants puisqu’ils vont déterminer la vitesse et la densité logique du 

système. Par exemple, les matrices de routage sont physiquement réalisées grâce à des 

transistors de cellules SRAM, qui ont une  résistance et une capacité, ce qui entraîne 

l’existence de constantes de temps. 

I.5 Illustration avec la famille Cyclone II Altera  

I.5.1 Caractéristiques principales de la famille Cyclone II 

Leurs principales caractéristiques sont : 

• Une gravure en 90 nm. C'est un paramètre important car plus la gravure est fine et plus 

l'élément de base qu'est le transistor est petit et voit sa consommation diminué, c'est-à-dire 

augmenter la densité d’intégration. 

NB: Graver plus fin permet également de placer davantage de portes dans le FPGA à surfaces 

égales. 

• Une architecture haute densité avec entre 4608 et 68416 LE (Eléments logiques). 

• Ils intègrent jusqu'à 1.1 Mbits de RAM (M4K Blocks) avec : 

- une largeur de bus de données configurable (x1, x2, x4, x8, x 16, x32 et x36), 

- un mode double accès, 

- une vitesse de fonctionnement pouvant atteindre 260 MHz. 

• Ils comprennent une zone où sont gravés dès la fabrication jusqu'à 150 Multiplexeurs 

18x18 (Embeded Multipliers). 

• Ils possèdent des blocs d'entrées/sorties avancées (IOE : Input/Output Element) avec : 

- des entrées/sorties différentielles (LVDS, LVPECL . . .), 

- des entrées/sorties simples (3.3v, 2.5v, 1.8v et 1.5v LVCMOS, 3.3v, 2.5v et 1.8v 

LVTTL . . .), 
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- une compatibilité avec les signaux PCI et PCI Express. 

• Il y a une circuiterie dédiée aux horloges (PLL) : 

- 2 à 4 PLL pour multiplier ou diviser les fréquences d'horloge entrantes, les retarder ... 

- jusqu'à 16 lignes d'horloges en interne 

- une gestion jusqu'à la fréquence maximale de 402.5 MHz 

• Un dispositif de configuration avec : 

- Un mode rapide pour une configuration en moins de 100 ms 

- Mode série ou JTAG possibles avec des mémoires de configuration série de bas coût. 

I.5.2 Architecture interne globale  

La figure ci-dessous représente un schéma synoptique de l architecture interne du Cyclone II  

 

Figure I.10 Structure interne d'un Cyclone II 

� Elément logique (LE) 

               C'est le plus petit élément de logique dans le Cyclone II. Sa structure apparaît sur la 

figure ci-dessous 
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Figure I.11 Structure d'un Logic Element LE 

Cette cellule reconfigurable contient divers éléments : 

• Une LUT (Look up table) à 4 entrées permettant le calcul de n'importe quelle fonction 

de 4 entrées. 

• Un registre de sortie programmable. 

 

� Les blocs de réseaux logiques (LAB) 

             Un bloc de réseaux logiques contient : 

• 16 Eléments Logiques (LE). 

• Un réseau d'interconnexion local pour la communication entre LE du même LAB (voir 

figure II.12). 

• Un accès direct aux éléments adjacents du LAB dans la structure du FPGA (voir 

figure II.12) tels que : 

- un autre LAB. 

- un bloc mémoire pour les LAB adjacents aux zones mémoires. 

- un signal d'horloge d'une PLL. 
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- un multiplexeur. 

- un IOE (Elément d'entrée/sortie). 

- un accès aux réseaux d'interconnexions lignes/colonnes pour atteindre n'importe 

quel point du composant. 

 

 

 

Figure I.12 Connexions chaînées entre LEs dans un LAB 
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Figure I.13 Connexion directe au niveau d'un LAB 

 

� Bloc d'entrée/sortie (IOE : Input Output Element) 

             Avec l'accroissement constant du nombre de standards d'entrées/sorties en 

électronique numérique, la conception d'un FPGA a progressivement nécessité de faire 

apparaître des blocs dédiés capables d'interfaçages s'adaptant à une grande diversité de 

situation. 

La frange supérieure des composants de la famille Cyclone II dispose donc de nombreux 

blocs d'entrées/sorties (I/O Banks) répartis à la périphérie du composant. 

La famille Cyclone II peut s'interfacer avec des circuits logiques : 

-  LVTTL et LVCMOS : Interfaçage avec des circuits logiques d'usage général, 

fonctionnant à des fréquences moins de 100MHz. 

-  SSTL : Standard mis en place pour la mémoire SDRAM DDR (Double Data Rate). 

-  HSTL : Signaux des mémoires QDR2 SRAM (Quad Data Rate). 

- LVDS (Low Voltage Differential Signaling) : Signaux différentiels (ils garantissent 

une plus grande immunité au bruit) pour des communications à fort débit (jusqu'à 

805Mbps) et faible EMI (émissions électromagnétiques) 



Chapitre I                                     Les circuits logiques programmables 

 

 Page 19 

 

- LVPECL (Low Voltage Positive Emitter Coupled Logic) : Signaux différentiels à 

haute immunité au bruit utilisés en vidéo, télécom, distribution d'horloge. 

- PCI et PCI Express Bus locaux des PC utilisés pour la connexion de car te d'extension 

(Vidéo . . .). 

I.6 Conclusion 

            Dans ce chapitre nous avons présenté les différents circuits logiques programmables 

et conclure que la technologie FPGA s’inscrit au sommet de l’évolution des composants 

logiques programmables et ouvrent de grandes perspectives en terme de cout, rapidité et le 

contrôle en temps réel.  
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II.1 Introduction 

     Les circuits programmables FPGA offrent et permettent a l’utilisateur l’avantage 

d’intégrer et d’implémenter des systèmes et fonctions beaucoup plus complexes sur un seul 

circuit (FPGA). 

IL existe des constructeurs joignent  des périphériques au circuit FPGA, tels que les ports de 

communications, des afficheurs, des ports d’extension,… et ils offrent des cartes (munies de 

FPGA+ périphériques) adéquates pour diverses applications, parmi ces carte celle que nous 

avons utilisé la DE2 de Altera.    

II.2  Vue générale sur la carte DE2 

               La figure ci-dessous  nous montre la disposition des composants de la carte DE2 et 

indique l emplacement des connecteurs et des composants. 

                           

Figure II.1 Aperçu de la carte DE2 

 

La carte DE2 a beaucoup de dispositifs permettent à l'utilisateur de faire de diverses 

implémentations de circuits, de simples à plusieurs projets multimédias.   

Les différents constituants de la carte DE2 sont : 
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� Un circuit Altera Cyclone® II 2C35 FPGA device. 

� Un circuit de configuration série Altera  EPCS16. 

� USB Blaster pour la programmation et l utilisation du contrôle API. 

� Une mémoire SRAM de 512 koctets. 

� Une mémoire SDRAM de 8 Moctets. 

� Une mémoire Flash de 4 Moctets. 

� SD Card socket 

� 4 boutons poussoirs  

� 18 interrupteurs (switches). 

� 27 LEDs (18 rouges et 9 vertes).  

� 2 oscillateurs (source d’horloge) de 50-MHz et 27-MHz. 

En plus de ceux-ci traits du matériel, la carte DE2 est accompagnée d un  support logiciel qui 

met en œuvre les standards et les interfaces d entrée/sortie et d un control panel pour faciliter l 

accès  au différents composants de la carte ou périphériques. Et aussi le logiciel est 

accompagné de plusieurs exemples de démonstrations qui illustrent les capacités avancées de 

la carte DE2.    

II.3 Schéma bloc de la carte DE2   

               La figure I.2 représente le synoptique de la carte et ses différents blocs constitutifs et 

leurs emplacements vis-à-vis de circuit FPGA. 
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Figure II.2 Schéma bloc de la carte DE2 

II.3.1 Les constituants de la carte DE2 

� Cyclone II 2C35 FPGA  

� 33,216 LEs (Logic Element) 

� 105 blocs RAM  M4K  

� 483,840 total RAM bits  

� 35 multiplicateurs 

� 4 PLLs  

� 475 pins I/O 

� FineLine BGA 672-pin package 

 

� Circuit de Configuration série et l’USB Blaster  

� circuit de configuration série  EPCS16 de Altera 

� L USB Blaster pour la programmation et l’utilisation du contrôle API  
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� SRAM  

� RAM statique de 512 Ko (256K x 16 bits)  

 

� SDRAM  

� de taille 8 Mo  

 

� Mémoire Flash  

� mémoire Flash de 4 Mo 

� bus de données de 8 bits   

 

� SD card socket  

� Muni de mode SPI pour l’accès a la carte SD 

 

� Boutons-poussoirs  

� 4 boutons poussoirs  

� Accompagnés de triggers de schmitt  

� Normalement élevés et  génère une impulsion vers le bas  lorsque l'interrupteur est 

enfoncé 

 

� Les Switchs  

� 18 interrupteurs (Switchs) a utiliser comme entrees 

� Un Switch est a l état 0 s il est en position vers le bas et a 1 s il vers le haut  

 

� Clock inputs  

� Oscillateur de 50-MHz  

� Oscillateur de 27-MHz  

� entrée SMA pour une horloge externe    

 

� CODEC Audio  

� Wolfson WM8731 24-bit sigma-delta audio CODEC  

� composé de 3 prises jacks Line-level input, line-level output, and microphone input  

� sa Fréquence d'échantillonnage de  8 à 96 KHz 
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� VGA output  

� Utilise le ADV7123 de 240 MHz et un triple DAC vidéo  (CNA) de 10-bit à grande 

vitesse  

� Prend en charge jusqu'à une résolution de 1600 x 1200 à un taux de rafraîchissement 

de 100 Hz  

 

� NTSC/PAL TV decoder circuit  

� Utilise le ADV7181B Multi-format SDTV Video Decoder  

� Intègre 3 ADCs (CANs) de 9-bits à 54-MHz  

� Il a une horloge d entrée de 27-MHz  

� Prend en charge des formats de sortie numériques (8-bit et 16-bit) 

 

� 10/100 Ethernet controller  

� Supporte les normes 100Base-T et 10Base-T en mode full-duplex 

� Entièrement compatible avec la norme IEEE 802.3u 

 

� USB Host/Slave controller    

� Il est complètement conforme à la norme 2.0 

� Prend en charge le transfert de données à pleine vitesse et à vitesse réduite  

� Prend en charge à la fois l'hôte USB et le périphérique 

� Prend en charge des E / S programmées (PIO) et l'accès direct à la mémoire (DMA) 

 

� Ports serie 

� Un port RS-232 plus un connecteur série DB-9  

� Un port PS/2 plus 2 connecteurs pour connecter une souris ou un clavier PS2  

 

� IrDA transceiver  

� Contient un émetteur-récepteur infrarouge de 115,2 kb / s 
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� Deux ports d’extension 

� 72 Cyclone II I/O pins, dont 8 pour l’alimentation et de masse, et 40-pins (broches) 

pour l’extension 

� Les 40 pins acceptent le standard câble ruban de 40 pins utilisées pour les disques dur 

IDE  

II.4 La tension d’alimentation  

               La carte est alimentée via un adaptateur 220V/9V, accompagnée d un bouton-

poussoir ON / OFF sur la carte DE2. 

II.5 Utilisation de la carte DE2 

               Ce titre donne des indications et  instructions nécessaires pour l'utilisation de la carte 

DE2 et décrit chacun de ses périphériques d'E / S.  

 

II.5.1 Configuration du FPGA Cyclone II  

               La procédure de ramener le circuit conçu à partir d'un ordinateur  à la carte DE2 est 

décrite dans le tutoriel Quartus II Introduction. Ce tutoriel se trouve dans le dossier 

DE2_tutorials sur l' DE2 CD-ROM Système et également disponible sur le site d'Altera 

DE2, pour bien comprendre la procédure l'utilisateur devrais lire le tutoriel d'abord, et 

consulter le manuel d’utilisation. Nous montrons ci-dessous le principe de fonctionnement et 

d utilisation de la carte DE2. 

Sur la carte on trouve série EEPROM qui enregistre les données de la configuration du 

Cyclone II FPGA. Ces dernières sont automatiquement chargées à partir de la mémoire 

EEPROM dans le FPGA. Avec l’utilisation du logiciel Quartus II, il est possible de 

reprogrammer le FPGA à tout moment, et il est également possible de modifier les données 

non volatiles (programme) qui sont stockées dans l’EEPROM.  

Les deux types de programmation sont décrits ci-dessous :  

• Programmation JTAG: Dans ce mode de programmation, nommé d'après les standards 

IEEE Joint Test action Groupe, le train de bits de configuration est chargé directement 

dans le cyclone II FPGA.  

Le FPGA conservera cette configuration tant que la carte est alimentée, et la configuration  est 

perdue des que  l'alimentation est coupée.  
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• programmation  AS : appelée programmation « Active Serial », Dans cette méthode,  

le flux de bits de configuration (programme) est chargé dans l’EEPROM « Altera 

EPCS16 ». Il permet le stockage non-volatile du train de bits, de sorte que 

l'information est conservée même lorsque l'alimentation de la carte DE2 est éteinte. 

Lorsque la carte est alimentée, les données de configuration dans le circuit EPCS16 

sont automatiquement chargées dans le FPGA Cyclone II.  

Les sections suivantes décrivent les étapes à suivre pour effectuer à la fois la 

programmation JTAG et AS. Pour les deux méthodes, la carte DE2 est connectée à un 

ordinateur via un câble USB. Avec cette connexion, la carte sera identifiée par l'ordinateur 

comme un périphérique « USB Blaster Altera ». Procédé ensuite a l'installation du pilote 

nécessaire de périphérique. 

 

II.5.1.1 programmation du FPGA en mode JTAG  

               La figure ci-dessous illustre la configuration de la programmation JTAG.  

Pour charger un flux de bits dans le Cyclone II FPGA, effectuez les étapes suivantes:  

• Assurer que la carte DE2 est alimentée  

• Branchez le câble USB fourni au port USB Blaster sur la carte 

• configurer le circuit de programmation JTAG en définissant la RUN / PROG commuter (sur 

la partie gauche de le conseil d'administration) à l' RUN la position.  

• Le FPGA peut maintenant être programmé à l'aide de Programmeur Quartus II, le fichier a 

sélectionner  est d'extension «. sof » 

 

 

Figure II.3 Le schéma de la configuration JTAG 
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II.5.1.2 Programmation de l EEPROM EPCS16 en mode AS  

               La figure ci-dessous illustre la programmation AS mise en place. Pour charger le 

programme dans l’EEPROM série EPCS16, effectuez les étapes suivantes:  

� Assurer que la carte DE2 est alimentée  

� Branchez le câble USB fourni au port USB Blaster sur la carte 

� configurer le circuit de programmation JTAG en définissant la RUN / PROG 

commuter (sur la partie gauche de le conseil d'administration) à l'PROG la position.  

� Le circuit EPCS16 peut maintenant être programmé à l'aide de Programmeur 

QuartusII, sélectionnez un fichier de programmation muni de l'extension « . pof »  

� Une fois l'opération de programmation est terminée, mettre le commutateur RUN / 

PROG à la position RUN, puis réinitialiser la carte sur le bouton ON/OFF. Cette 

action provoque la  mise d’un nouveau programme dans l’EPCS16. 

 

Figure II.4 Le schéma de la configuration AS 

 

En plus de son utilisation pour  la programmation, le port USB Blaster de la carte DE2 peut 

également être utilisé pour contrôler certaines fonctions de la carte à distance depuis un 

ordinateur. 

  

II.5.2  Utilisation des boutons-poussoirs et des Switchs  

               La carte DE2 fournit quatre boutons-poussoirs. Chacun des boutons est anti-rebonds 

en utilisant un trigger de Schmitt, comme c’est indiqué à la figure I.5, les quatre sorties des 

triggers sont KEY0, KEY1, KEY2, KEY3, elles sont reliées directement aux pins de l’FPGA. 

Chaque bouton fournit un niveau logique haut de 3,3 volts quand il n'est pas enfoncé, et un 

niveau logique bas de 0 volt dans le cas contraire.  

Étant donné que les boutons poussoirs sont anti-rebond, elles sont appropriées pour une 

utilisation comme horloge ou réinitialiser les entrées d'un circuit.  
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Figure II.5 Représentation du trigger  anti rebondissement 

 

La liste des noms des pins du l’FPGA qui sont connectés aux boutons-poussoirs est donnée 

dans le Tableau 2.1 dans l’annexe 2. 

                  Il ya aussi 18 Switchs sur la carte DE2. Ils ne sont pas anti-rebonds, sont destinés à 

être utilisés comme des entrées de données d’un circuit. Chacun d’eux est connecté 

directement à une broche de l’FPGA Cyclone II. Lorsqu'un interrupteur est en position vers le 

bas, il fournit un niveau logique bas (0 volt) pour le FPGA, et lorsqu’il est dans la position 

haut, fournit un niveau logique haut (3,3 volts). 

 La figure ci-dessous montre les circuits électriques des boutons-poussoirs et des Switchs. 

 

Figure II.6 schéma électrique des Switchs et des boutons poussoirs 
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La liste des noms des broches du l’FPGA qui sont connectés aux Switchs est donnée dans le 

Tableau 2.2 dans l’annexe 2. 

 

II.5.3 Utilisation des LEDs  

               La carte dispose de 27 LEDs contrôlables par l'utilisateur, dont 18 rouges sont situés 

au-dessus de la 18 Switchs, et 8 vertes se trouvent au-dessus des boutons-poussoirs, la 9eme 

est verte située au milieu des afficheurs 7 segments. Chaque LED est connectée directement à 

une broche sur l’FPGA. 

Les circuits électriques des LEDs sont donnes dans la figure suivante  

 

Figure II.7 schéma électrique des LEDs 

 

La liste des noms des pins du l’FPGA qui sont connectés LEDs est donnée dans le Tableau 

2.3 dans l’annexe 2. 
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II.5.4 Utilisation des afficheurs 7 segments  

               La carte DE2 a huit afficheurs 7 segments. Ces derniers sont disposés en deux paires 

et un groupe de quatre, avec l'intention d'afficher des numéros de différentes tailles.  

L'application d'un niveau logique bas à un segment amène à éclairer, et l'application d'un 

niveau logique haut l éteint (les afficheurs sont a anodes communes). Chaque segment d'un 

afficheur est identifié par un index de 0 à 6. 

 

 

Figure II.8 Position et index de chaque segment d'un afficheur 7 segments 

 

Et  les schémas de la figure I.9 nous montre comment que  les afficheurs 7 segments sont 

reliés aux broches de l’FPGA, et on voie bien que le point dans chaque afficheur n’est pas 

connecté donc  n’est pas utilisable.   
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Figure II.9 Brochage des afficheurs 7 segments 

NB: Le Tableau 2.4 dans l annexe 2 montre les affectations des broches du FPGA vers les 

afficheurs 7 segments. 

 

II.5.5 Les horloges d’entrées  

               La carte DE2 comprend deux oscillateurs de 50 MHz et 27 MHz, et comprend 

également un connecteur SMA utilisable lors que la source d'horloge est externe.  
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Figure II.10 Schéma du circuit d'horloge 

 

II.5.6 Utilisation de l’afficheur LCD   

               Le module LCD est utilisé pour afficher du texte en envoyant des commandes 

appropriées au contrôleur d’affichage (HD44780). On trouve des informations détaillées sur 

le datasheet du circuit.  
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Figure II.11 Schéma de principe du module LCD 

 

II.5.7 Utilisation des ports d'extension  

               La DE2 offre deux ports (connecteurs) d'extension de 40 broches. Chaque port se 

connecte directement à 36 pins de l’ FPGA, et fournit également  un DC 5 V (VCC5), VCC 

3,3 (VCC33), et deux broches GND.  

La figure ci-dessous montre les schémas associés. Chaque broche sur les ports d'extension est 

connectée à deux diodes et une résistance qui offrent une protection de haute et basse 

tensions. La figure montre  Le circuit de protection pour seulement 4 broches sur chaque port, 

mais ce circuit accompagne 72 pins sur les 2 ports.  
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Figure II.12 schéma électrique des ports d’extensions 

 

II.5.8 Utilisation du port VGA   

               La carte comprend un connecteur D-SUB 16 broches pour la sortie VGA. La 

synchronisation des signaux VGA se fait à partir du FPGA, et ADV7123 triple DAC 10 bits 

est utilisé pour convertir les signaux de données en analogique (rouge, vert, bleu). Il peut 

prendre en charge une résolution allant jusqu'à 1600 x 1200 pixels, à 100 MHz.  
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Figue II.13 schéma et circuit du port VGA 

 

II.5.9 Utilisation du codec audio 24-bit  

               La carte DE2 possède (WM8731) Encodeur / décodeur audio de 24 bits haute qualité 

au port microphone, line-in et line-out, travaillant dans la plage 8 kHz à 96 kHz. Le WM8731 

est commandé par une interface de bus série I2C, qui est le relie à l’FPGA. 
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Figure II.14 schéma éclectique du codec audio 

 

II.5.10 Le port série  RS-232  

               La DE2 utilise le MAX232 et un connecteur SUB-D  de 9 broches pour la 

communication RS-232.  

 

Figure II.15 schéma et circuit du MAX232 et RS-232 
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II.5.11 Le port série PS / 2  

               La carte comprend une interface standard PS / 2 et un connecteur pour clavier ou 

souris PS / 2. 

 

Figure II.16 schéma et circuit du PS/2 

 

II.5.12 Contrôleur Fast Ethernet  

               La carte DE2 est dotée d’un contrôleur Fast  Ethernet le Davicom.  DM9000A, ce 

dernier comprend l’interface générale du processeur, une SRAM de 16 Ko, une unité de 

contrôle d'accès au support (MAC), et un émetteur-récepteur PHY 10/100M.  

 

 

Figure II.17 schema du module Fast Ethernet 

 

\ 



Chapitre II                                                     Présentation de la carte DE2  

 

 Page 38 
 

II.5.13 Le décodeur TV  

               La carte DE2 est équipée du circuit décodeur  TV le ADV7181,c’est un décodeur 

vidéo intégré qui détecte et convertit un signal télévision en bande de base standard 

analogique (NTSC, PAL et SECAM) en 4:02:02 données vidéo en composantes compatibles 

avec 16-bit/8-bit (CCIR601/CCIR656). Le ADV7181 est compatible avec une large gamme 

d'appareils vidéo, comme les lecteurs de DVD, sources sur bande, sources de diffusion, et les 

caméras de surveillance.  

Les registres du décodeur TV peuvent être programmés par un bus I2C, qui le relie à l'FPGA. 

 

Figure II.18 schéma du décodeur TV 

 

II.5.14 La mise en œuvre d'un encodeur TV  

               Bien que la carte DE2 ne comprend pas un module d'encodage TV, le ADV7123 

(10-bit high-speed triple ADCs) peut être utilisé comme un encodeur TV de qualité 

professionnelle avec la partie de traitement numérique dans le FPGA. 
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Figure II.19 L’encodeur TV qu’utilise le FPGA Cyclone II (ADV7123) 

 

II.5.15 Utilisation de l’USB Host (pilote) et Périphérique  

               La carte DE2 met à disposition à la fois l'hôte USB et les circuits d’interfaces en 

utilisant le Philips ISP1362. Les contrôleurs hôte (maitre) et les contrôleurs USB sont 

conformes à l’Universal Serial Bus Specification Rev. 2.0, soutenant du transfert de données à 

pleine vitesse (12 Mbit / s) et basse vitesse (1,5 Mbit / s).  
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Figure II.20 schéma du host et périphérique USB 

 

II.5.16 L'utilisation du IrDA  

La carte DE2 fournit un moyen de communication sans fil simple en utilisant un 

émetteur-récepteur infrarouge l’Agilent HSDL-3201. 

Notez que le taux de transmission avec une vitesse max est de 115.2 Kbit / s. La figure ci-

dessous montre le schéma de la liaison de la communication IrDA. 

Figure II.21 Schéma du IrDA 
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II.5.17 Utilisation des RAM flash SDRAM / SRAM  

               La carte DE2 fournit une mémoire SDRAM de 8 Mo, SRAM de 512 Ko. Les figures 

suivantes montrent les schémas des puces mémoire.  

                  

Figure II.22 Le bloc SDRAM 

 

Figure II.23 Le bloc de la mémoire FLASH 
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Figure II.24 Le bloc SRAM 

 

II.6 Conclusion  

               Ce chapitre a été dédié à la présentation de la carte DE2 en expliquant les différents 

éléments constituant et ses diverses utilisations que nous exploiterons dans le chapitre suivant.  
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III.1 Introduction            

Pour poursuivre un objet en mouvement on dispose d’un moteur pas a pas sur lequel est fixé 

un capteur CCD; et une carte DE2 sur laquelle nous allons implémenter un programme de 

commande et de poursuite sous la plateforme de développement Quartus. 

III.2 Capteur CCD ou CMOS 

 L’appareil photo ou le scanner sont dotés de capteurs traduisant des rayons lumineux 

colorés en signaux numériques. Ce signal est enregistré en valeurs mathématiques plus ou 

moins complexes donc plus ou moins "lourdes". Ce capteur est composé de millions de 

photosites, chaque photosite étant muni d'un filtre R, V ou B pour enregistrer un signal 

exclusivement R, V ou B, le photosite vert étant deux fois moins sensible sera doublé, il faut 

donc 1 photosite R, 1 B et 2V pour obtenir un pixel après traitement dans le logiciel de 

l'appareil. Pour des raisons pratiques de fabrication les photosites actuels sont de forme 

carrée, cela devrait changer dans le futur, on voit apparaître des photosites hexagonaux qui 

devraient réduire l'effet d'escalier (pixellisation) sur les agrandissements et permettre ainsi une 

augmentation de la qualité. 

 

III.3 Généralités sur l’image 

III.3.1 Le Pixel 

 Un pixel a une couleur exprimée (codée) en langage binaire mathématique 

(uniquement des 0 et des 1). L'œil humain est capable de discerner aux environs de 220 

nuances dans une couleur. On comprend donc tout de suite qu'il faut cette quantité minimum 

de nuances pour avoir une qualité correcte, appelée parfois qualité photo. Ce seront donc 

toujours des multiples de 2 en progression géométrique qui donneront les valeurs de travail 2, 

22, 24, 28, 212, 216
 ..... 

C'est 28 soit 256 qui se rapproche le plus des 220 niveaux requis pour une bonne séparation 

des nuances, on comprend donc tout de suite pourquoi on retrouve la majorité des APN réglés 

sur 256 niveaux de nuances par couleur.  

  

III.3.2 L’image 

III.3.2.1Définition  

 Une image est avant tout un signal 2D (x,y), cette image représente une réalité 3D(x,y 

,z). D'un point de vue mathématique une image est une matrice de nombres représentant un 
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signal une image contient plusieurs informations sémantiques il faut interpréter le contenu au-

delà de la valeur des nombres. 

 Une image matricielle est formée d'un tableau de points ou pixels. 

 Plus la densité des points est élevée, plus le nombre d'informations est grand et plus la 

résolution de l'image est élevée. 

 Corrélativement la place occupée en mémoire et la durée de traitement sera d'autant 

plus grandes. Les images vues sur un écran de télévision ou une photographie sont des images 

matricielles. On obtient également des images matricielles à l'aide d'un appareil photo 

numérique, d'une caméra vidéo numérique ou d'un scanner. 

 

III.3.2.2 Types d'images 

Images en niveaux de gris I(x,y) Î [0..255] 

Images binaires I(x,y) Î {0 , 1} 

Images couleurs IR(x,y) IG(x,y) IB(x,y) 

 

III.3.2.3 Représentation des images 

 Une image est une matrice de dimension M *N, et chaque élément à une valeur entière 

dans l'intervalle [Lmin , Lmax]. Le nombre de « bits » requis pour représenter les niveaux de 

gris dans l’intervalle « L » est « K » tels que: L = 2k , Le nombre de bits pour entreposer une 

image est donc : b = M *N *K. 

 

III.3.2.4 L’image RGB (RVB)  

 L'image est obtenue par superposition de trois rayonnements lumineux, le rouge (R), le 

vert (V) et le bleu (B). Une image RVB est composée de la somme de trois rayonnements 

lumineux rouge, vert, et bleu dont les faisceaux sont superposés. A l'intensité maximale ils 

produisent un rai de lumière blanche, et à l'extinction une zone aussi noire que l'éclairage 

ambiant le permet (c'est la raison pour laquelle vous avez installé le moniteur de votre 

ordinateur dans une pièce où règne, autant que faire se peut une certaine pénombre, et qu'un 

rayon de soleil qui frappe en plein un écran le rend presque illisible).  

 Si vous mettez le nez sur l'écran de votre moniteur (ou mieux encore sur celui de votre 

téléviseur, dont le pas est plus grossier) vous distinguerez les trois sources RVB en forme de 

nid d'abeille, ou de grille, qui donnent l'illusion d'un fond blanc. 
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En fait, croyant voir un point blanc, vous percevez simultanément trois lumières rouge, vert et 

bleu. La gamme des couleurs reproductibles par ce mode, quoique conditionnée par la qualité 

du matériel employé, est très étendue, et reproduit bien les couleurs saturées. 

En contrepartie, elle convient mal à la restitution des nuances délicates des lumières intenses 

et des tons pastel. 

 

L'image est codée en 8 bits par couche (28 = 256 niveaux) soit 8 pour le R, 8 pour le V, 8 pour 

le B au total 24 bits en RVB. 

Remarque : Il existe aussi d’autres codages de la couleur que RVB… 

 

Figure III.1 montre les 3 couleurs constitutives de limage 

III.4 La plateforme de développement Quartus 

III.4.1 Présentation 

Les fabricants de circuit fpga tels  Xilinx ou Altera offrent des environnements de 

développement qui constituent une excellente base de travail. De sa part, Altera propose 

l’outil de conception Quartus II.  
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III.4.1.2 L’environnement Quartus II 

L'environnement de Quartus II est le suivant :   

 

  
 
 

 

L’environnement se découpe en 4 parties, une pour l’éditeur de code qui apparait après avoir 

créé un nouveau projet, 3 sont visibles après le lancement de Quartus. 

 
� Une fenêtre Project Navigator : qui contient toutes les informations relatives au 

projet dont les détails sur la hiérarchie du projet, les fichiers le constituant, les 

différentes unités définies (entités, architecture, schémas, machines d'états ...). 

� La fenêtre Tasks : présente les différentes tâches du Design Flow avec la possibilité 

d'accéder à l'ensemble des processus de traitement de Quartus et les comptes rendus 

associés.  

� La fenêtre Messages : permet d'être informé en continu des informations, 

avertissements et erreurs apparaissant lors de l'exécution des diverses tâches. 

Figure III.2 l’environnement de développement Quartus II  
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III.4.1.3 Développement sous Quartus II 
 

� Création d’un projet sous Quartus 
 

Après avoir démarrer Quartus , on crée un nouveau projet : File -> New Project... 
 

� La première boite de dialogue qui apparait permet de fixer le nom du projet et son lieu 
de stockage : 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

� Dans la seconde, il est possible d'ajouter des fichiers déjà existants au projet. Ne rien 

ajouter et cliquer sur le bouton Suivant. 

� La troisième fenêtre de dialogue permet de choisir le FPGA ou CPLD ciblé. 

� Une fois choisi, on en termine avec l'assistant de création de projet en cliquant sur 

Finish. 

La réalisation sous Quartus amène à l'écriture de 3 sources VHDL et d'un schéma 

hiérarchique. 

• Ajout d’une source VHDL 

Pour ajouter une nouvelle source VHDL : File -> New... et on choisit une source de type 

VHDL (il est intéressant de remarquer l'étendue des possibilités en matière de source). 

 

 

Figure III.3 création de projet sous Quartus 



Chapitre III                                                                                    Application 

 

 Page 48 

 

• Sauvegarde d’un projet 

              Après avoir taper le code, la sauvegarde se fait comme suite : File -> Save As...puis 

entrer un nom avec l’extension .vhd ). 

 

• Inclure un modèle 

          Il est possible d'inclure des modèles d'un simple clic dans le code source 

en cours d'édition. Cet outil (Template) est accessible via le menu Edit -> 

Insert Template... ou via l'outil dans la palette d'outils de l'éditeur. 

 

� Vérification de la syntaxe du code 

 

          Quartus propose un outil de contrôle d'erreur pour limiter la présence de 

coquilles et d'erreurs d'inattention syntaxique dans le code.  On le fait comme 

suite : Menu Processing -> Analyse current file ou l'outil   dans la palette 

d'outils de l'éditeur). 

 

� Création d'un stimulus de simulation 

 
           Quand le code VHDL est correct en matière de syntaxe,  il  est ensuite 

nécessaire de le tester en lui appliquant différents vecteurs de test, la solution pour 

réaliser ce test avec Quartus II est l'éditeur graphique de vecteurs de test (Vector 

Waveform Editor). 

 

� Pour créer un fichier de test graphique, atteindre le menu et faire File -> New... et 

choisir Vector Waveform File. utiliser la commande Save As... pour enregistrer le 

fichier de test. 

� Pour rendre les signaux d'entrées et de sorties accessibles à l'édition dans l'éditeur 

graphique, il faut réaliser une compilation de Design : menu Processing -> Start 

Compilation. 

� Ajouter des signaux d'entrée : 

• Pour créer des stimuli sur les entrées, il faut ajouter les signaux d'entrées dans la 

colonne Name par un double clic dans cette même colonne (ou la commande Insert -> 

Insert Node or Bus... du menuEdit). Poursuivre par un clic sur le bouton Node 
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Finder... de la boite de dialogue qui apparaît. Dans le second dialogue, sélectionner 

Pins :all  dans la boite de liste Filter et lancer l'opération de filtrage par un clic sur le 

bouton List. 

• Ajouter les signaux d’entrée dans la liste des signaux sélectionnés (Selected Nodes) en 

utilisant le bouton > . Puis valider par OK deux fois. 

� Donner un stimulus à un signal : 

• Sélectionner le signal dans la colonne Name. 

• Création d'un signal de type horloge pour le stimulus du signal sélectionné: Menu 

Edit -> Value -> Clock...(ou cliquer sur l'outil  de création d'horloge). On remplit 

le dialogue d'horloge pour créer une horloge. Pour changer la durée de la simulation, 

utiliser la commande du menu Edit -> End Time... 

 
� Simulation du projet 

  
         Il convient préalablement de définir les paramètres de simulation en accédant à la boite 

de dialogue correspondante (menu Assigments -> Settings puis Category Simulator Settings 

ou également par la fenêtre de tâches,  section Verify Design -> Simulate Design -> Quartus 

II simulator -> Edit settings). 

 

� Choisir une simulation fonctionnelle (Functional Simulation) pour le mode de 

simulation (Simulation mode). 

� Ajouter le fichier test.vwf pour les paramètres d'entrées de la simulation (Simulation 

input). 

� Valider par OK. 

� Dans la fenêtre des tâches, lancer la simulation par un double clic sur Quartus II 

Simulator (Functional). 

� Pour une simulation temporelle, choisir Timing pour le mode de simulation. 

 
III.5 Description du moteur pas-a-pas  

III.5.1 Généralités : 

         Un moteur pas à pas est un moteur dont la partie mobile se déplace d’une quantité 

élémentaire appelée PAS chaque fois que le moteur reçoit une impulsion de courant 

convenable.   



Chapitre III                                                                                    Application 

 

 Page 50 

 

À chaque pas, on obtient un déplacement angulaire. On définit alors le nombre de pas par  

tours : 

 

- pour les moteurs les plus courants, on trouve : 12  24  36  48  60  100  200  400  pas 

par tours 

- le pas angulaire correspondant étant respectivement : 30°  15°  10°  7.5°  6°  3.6°  1.8°  

0.9° 

        D’autre part, ces remarquables possibilités d’adaptation lui permettent également  de 

pouvoir travailler selon le cas à vitesse continue ou variable. 

III.5.2 Commande d’un moteur pas à pas  

Pour commander un moteur pas-à-pas il est nécessaire de passer par une chaine de commande 

constituée de différents étages : Unité de pilotage, Production des signaux de commande 

du moteur pas-à-pas, Etage amplificateur. Ces différents étages sont illustrés par la figure 

suivante 

 

Figure III.4 Les différents étages de commande d’un moteur pas-à-pas 

 

Unité de pilotage : elle permet de commander :  

    - le sens de rotation,  

    - l’angle de rotation et donc la vitesse qui en résulte.  

Production des signaux de commande du moteur : elle permet de produire les signaux de 

commande des moteurs pas à pas. Ces signaux dépendent du choix du mode de 

fonctionnement du moteur pas à pas.  
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Amplification en puissance : cette fonction permet d’amplifier en puissance les signaux de 

commande du moteur afin de pouvoir commander le moteur pas à pas. Cette fonction dépend 

des caractéristiques du moteur pas à pas.  

Moteur pas à pas : le moteur pas à pas permet de convertir les signaux de commande du 

moteur pas à pas en déplacement linéaire ou angulaire. 

III.5.1.1 Les différents modes de commande des moteurs pas à pas  

         Les modes de fonctionnement des moteurs pas à pas sont obtenus par la fonction :                 

« Production des signaux de commande du moteur ».   

Alors que l’alimentation (unipolaire ou bipolaire) sera fixée par la fonction 

«Amplification en puissance ». 

 
 

Figure III.5 Mode de commande une phase "on"  pas entier : one phase on drive mode 

   

Les phases du moteur pas à pas sont alimentées l’une après l’autre, à chaque impulsion de 

l’horloge l’angle de rotation est équivalent à un pas. 
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Figure III.6 Mode de commande demi-pas : half step mode 
 

         Les bobines sont alimentées alternativement une seule, et ensuite les deux. À 

chaque impulsion d’horloge l’angle de rotation est équivalent à un demi-pas, ceci permet 

de gagner en précision avec un même moteur. 

 
Figure III.7 Mode de commande 2 phases "on" pas entier : two-phase-on drive mode 

 

         Le mode de commande ci-dessus est en pas entier, la seule différence est que l’on 

alimente à chaque fois deux phases à la fois ceci permet d’avoir un couple plus élevé. 
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Figure III.8 Mode de commande demi-pas ** (couple constant) : half step mode 

Ce mode de commande permet d’obtenir un fonctionnement en demi pas à couple constant (la 

somme des tensions appliquées sur les bobines est toujours constante, contrairement au mode 

demi pas classique où une bobine est alimentée puis deux …). 

Remarque dans application on utilise une commande pour un moteur pas à pas. 

 

III.6 La partie programmation 

III.6.1 Principe et raisonnement  

On a vu précédemment que l’image est une matrice de pixels, chaque pixel est représenté sur 

8bits pour trois couleurs,  rouge, vert, bleu, donc trois matrices. On va exploiter cette 

représentation de l’image pour le suivi d un objet se mouvant dans une ligne droite (gauche, 

droite) (admet un seul degré de liberté). 

� La partie acquisition  

Lors de l’acquisition de vidéos (succession d’images), on utilise un capteur CCD avec un 

arrière plan blanc, donc l’image sans l’objet est blanche ce qui implique que les trois matrices 

qui représentent l’image référence (blanche) sont des matrices de « 1 ». 

 



Chapitre III                                                                                    Application 

 

 Page 54 

 

� Le prétraitement  

Les images dans lesquelles figure l’objet sont différentes de l’image référence dans les pixels 

représentant l’objet. 

� La comparaison 

Pour localiser l’objet dans l’image, on effectue une comparaison entre les trois matrices 

acquises (R, V, B) la où se figure l’objet avec l’image référence (entièrement blanche) pour 

déterminer seulement la partie couverte par l’objet. 

Pour cela on effectue l’opération XOR entre les trois matrices et la matrice référence, donc on 

aura  trois matrices, chacune d’elle indique les zones occupées par le rouge, le vert, et le bleu 

contenus dans l’objet, ensuite on regroupe les trois matrices en une seule en utilisant 

l’operateur logique OU en elles, et cela va garder toujours le fond en « 00000000 » (zone hors 

objet).  

 

� Détermination de position 

Le but de programme est de veiller à mettre l’objet au centre de l’image, au début on doit 

centrer l’objet dans l’image pour déterminer ses dimensions et mettre les indices pour s’en 

référencier lors de la comparaison avec les images entrantes (envoyées par le capteur). 

 

Figure III.9 image montrant l’objet au milieu 

Dans notre cas, nous avons utilisé un seul indice « bg » (borne gauche), pour une ligne bien 

déterminée « lg » on fait un balayage de haut en bas, de gauche à droite. 
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 Dans notre cas le mouvement du capteur est commandé par un seul moteur, ce qui signifie 

qu’il admet un seul degré de liberté horizontal (gauche, droite). 

A  la première rencontre du premier pixel différent de « 00000000 » (contour de l’objet), la 

position de ce pixel sera comparée à l’indice « bg » (borne gauche).  

� S’il est inferieur (l < bg), l’objet est à gauche par rapport au centre, ce qui induira 

l’enclenchement du moteur, il tournera vers la gauche jusqu’à l=bg, ce qui signifie 

que l’objet est centre. 

 

Figure III.10 image montrant l’objet à gauche 

� S’il est supérieur (l > bg), le moteur va orienter le capteur vers la droite jusqu’à l=bg. 

 

Figure III.11 image montrant l’objet à droite 
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III.6.2 Mise en application 

� Les traitements effectués sur l’image et la détermination de la positon de l objet par 
rapport au centre jusqu’a l’enclenchement des moteurs sont donnes dans 
l’organigramme suivant: 

 

Figure III.12 Organigramme de positionnement et de commande 
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- R, V, B les les matrices qui constituent l’image acquise de taille m*n 

- Ref : c est la matrice de l’image référence qu’on a pris sans l’objet (entièrement 

blanche)  

- Synth : La matrice de synthèse des traitements effectués sur l’image 

- lg : la position ou la ligne ou se situe l’indice qu’on a mis dans la matrice dans le cas 

ou l’objet situé au centre. 

- bg : La position (la colonne), ou se situe l’indice, dans le cas ou l’objet est centré 

- Ing, ind : Variables de sortie et d’entrée de la machine a états pour l’enclenchement du 

moteur (gauche, droite respectivement)   

� Le séquencèrent du moteur est représenté par la machine à état suivante :  

telle que l’entrée est a 2 bit est « ing ind »utilises comme sortie dans l’organigramme.  

                                                          

 

Figure III.13Machine a état pour générer les signaux de commande du moteur 
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Le moteur admet 4 combinaisons de commande telle qu’on le voit sur la figure III.13 
  

- S0 représente la sortie « 1100 » 
- S1 représente la sortie « 0110 » 
- S2 représente la sortie « 0011 » 
- S3 représente la sortie « 1001 » 

                                                  
         
III.6.3 Résultats de simulation 

� Dans le cas ou l’objet dans le coté  gauche 
 

 
Figure III.14 Signaux de commande du moteur dans le cas ou l’objet est a gauche de l’image 
 

� Dans le cas ou l’objet dans le coté droit 
 

 
 
Figure III.15 signaux de commande du moteur dans le cas ou l’objet est a droite de l’image 
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� Dans le cas ou l’objet est au centre 

 

 
 
 
 Figure III.16 Signaux de commande du moteur dans le cas ou l’objet est au centre de l’image 
 
 
III.7 Conclusion 
 
Dans chapitre nous avons adopté une approche expérimentale pour  implémenter notre 

solution de suivi d’objet par une commande de moteur pas à pas. 

Les algorithmes utilisés ont été validés par simulation sous le logiciel Quartus, le choix des 

fonctions logiques binaire permet d atteindre nos objectifs en un minimum de temps  de 

traitement.  

 
 
 
 
 
 
 
 
 
 
 
 
 



 

 

 

 

 

 

Conclusion 
générale 

 

 

 

 

 

 



Conclusion 

 

Le travail qui m’a été confié nous a permis de découvrir le monde de la 

programmation des systèmes embarqués et le domaine du temps réel, j ai eu l’occasion de 

programmer expérimentalement un circuit logique programmable de type FPGA, sous 

l’environnement de développement QUARTUS d’ALTERA sous différents modes de 

programmation. 

Durant la préparation de ce mémoire, on s’est heurté à la difficulté de l’acquisition 

vidéo et le traitement d’image ainsi que la commande. En dépit de ces difficultés, nous 

espérons avoir été a la hauteur du travail qui nous a été proposé. 

Notre travail peut être amélioré et peut constituer des perspectives très intéressantes.  

Enfin, nous espérons que notre travail puisse servir de support pour les promotions à 

venir.       
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Annexe : 

Le brochage de chaque périphérique et les assignements des pins dans le cicuit FPGA sont 
représentés dans les tableaux suivants : 

 

 

Tableau 1 Liste des pins connectées aux boutons-poussoirs 

 

 

 

 

Tableau 2 Liste des pins connectées aux Switchs 



 

Tableau 3 Liste des pins connectées aux LEDs 



 



 

 

 

 

Tableau 4 Liste des pins connectées aux afficheurs 7 segments 

 

 

 

Tableau 5 Liste des pins connectées aux horloges d’entrée  

 

 

 



 

 

 

 

 

Tableau 6 Liste des pins connectées a l’afficheur LCD 

 

 

 



 



 

 

 

 

Tableau 7 Liste des pins connectées aux ports d'extension 



 

Tableau 8 Liste des pins connectées a l’ADV7123  



 

 

 

 

Tableau 9 Liste des pins connectées au codec audio 

 

 

 

 

 

Tableau 10 Liste des pins connectées au port série  RS-232 

 

 

 

 

Tableau 11 Liste des pins connectées au port série PS / 2 

 

 

 



 

 

 

 

Tableau 12 Liste des pins connectées au Contrôleur Fast Ethernet 

 

 

 

 

 



 

Tableau 13 Liste des pins connectées au décodeur TV 

 

 



 

 

 

 

 

Tableau 14 Liste des pins connectées au port USB 

 

 

 

 

 

 

Tableau 15 Liste des pins connectées a l’ IrDA 

 

 

 

 

 

 

 



 

 

 

 

 



 

Tableau 16 Liste des pins connectées a la SDRAM 

 

 

 

 

 

 

 



 

 

Tableau 17 Liste des pins connectées a la SRAM 

 

 



  

 

Tableau 18 Liste des pins connectées aux 


